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1. Introduction 
This guide provides information about RefWorks 2.0 for students and staff using 
Anglia Ruskin University Library services.  
 
RefWorks 2.0 supports efficient time management when literature searching, writing 
and formatting documents by enabling you to create a personal database of 
references and compile instant bibliographies in a variety of styles. It is a web-based 
service accessed via the internet and can also be used off-line. 

Linking to full text 
RefWorks will link your references to Anglia Ruskin’s Digital Library using the ‘Check 
Full Text’ button in Standard and Full view. Other direct links may also be listed e.g. a 
link to a document in PubMed. 
 
You can convert an existing database from another bibliographic management 
program.  RefWorks 2.0 online Help gives instructions for exporting from each named 
product, including Endnote and Zotero.  

2. Getting started: create an account with University login. 
Start at our University Library website www.libweb.anglia.ac.uk. Click on 
Referencing, then RefWorks from the expanded menu. 

 
 
Follow the instructions for ‘New users’; you will need your Anglia Ruskin University 
login to create your RefWorks account. 
If you need help with your University Login, please contact the Student IT Help Desk 
student-ithd@anglia.ac.uk (students only) or ISMS isms-support@anglia.ac.uk (staff) 
 
When you have logged in, register your details with RefWorks.  
Click on 'new user', type in name, email, select a user type from the drop down menu 
and also select a 'focus area' (or subject).  
 
There are quick start guides, tutorials and full supporting information in alternative 
formats from the internal RefWorks ‘Help’ menu. 
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Use the Quick Access sidebar within RefWorks 2.0 if you wish to customise your 
account. You can change the default source type to ‘Electronic ‘in the ‘Import 
options’. 

 

 

2.1 RefWorks account login. 
You may see the RefWorks account login page when importing references from other 
data sources.  
 
• Click on ‘My Institution’s credentials (Shibboleth)’  
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• Select "Anglia Ruskin University" from the drop-down list.  
 

 
 
 
 
• Type in your University login to open RefWorks. 
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2.2 Navigating within RefWorks 2.0 
Use the menu tabs, icons and Quick access sidebar to navigate within RefWorks 2.0 
 

 

2.3 Output styles and the Anglia Ruskin University version of the 
Harvard Style 
To select the version of the Harvard Style currently used by Anglia Ruskin University 
for your forms and bibliography output: 
• In RefWorks 2.0 menu bar, click ‘Bibliography,’ then ‘Output Style Manager’ from 

the drop-down list. 
• Select ‘Anglia Ruskin Harvard Style v2’ from the list of Output Styles. 
• Click on the green arrow to add it to your ‘Favorites.’ 
 
The form and bibliography functions will now contain the option to choose the style 
from the drop-down list of your RefWorks Favorites. 
Use this process to choose alternative output styles; Harvard is an author/date style; 
Nature is a numbered bibliography (the same as creating endnotes). To create a 
paper with footnotes try the Chicago Notes format. 

3. Adding references to your database: fill in a RefWorks 
form manually 
This is the most straightforward way, either typing in directly, or copy and paste 
relevant information into the form. When you edit a reference you see this form too. 
• Click on the ‘New Reference button.’ A form will open for you to complete. 
• Choose Anglia Ruskin Harvard Style v2 as the output style from the drop-down 

menu.  
• Choose the form for the type of reference you are adding; the form gives different 

prompts depending on the reference type. E.g. book or journal. 
• Select the Source Type, print or electronic. 
• Fill in the form. Note that there are mouse roll-over notes to help you fill in the 

fields for Anglia Ruskin Harvard Style v2, for example, the Data Source field note: 
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• Save the reference. You can now attach a file to the reference, E.g. PDF of a 

journal article. 
 
 
The forms recommended for use when entering data manually with the output style 
Anglia Ruskin Harvard Style v2 are: 
 
Reference Type Print Version e-Version 
Abstract   
Artworks Recommended  
Bills Recommended  
Book Edited Recommended Recommended 
Book Section Recommended Recommended 
Book Whole Recommended Recommended 
Cases/Court Decisions Follow accepted legal 

practice 
 

Computer Programme   
Conference 
Proceedings 

Recommended Recommended 

Dissertation/Thesis Recommended Recommended 
Dissertation 
unpublished 

  

Generic Use with caution  
Grant   
Hearing   
Journal Article Recommended Recommended 
Journal Electronic   
Laws/Statutes Use with caution  
Magazine Article   
Map Recommended  
Monograph   
Motion Picture Use Video/DVD  
Music Score   
Newspaper Article Recommended See journal articles 
Online Discussion 
Forum/Blogs 

 Recommended 

Patent Recommended  
Personal 
Communication(e-mails) 

 Recommended 

Report Recommended  
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Sound Recording   
Unpublished Material   
Video/DVD Recommended  
Webpage  Recommended 
  
 
Some data sources are more reliable than others. You are advised to check the 
accuracy of the reference after importing by viewing and editing the form. 

4.  Importing references from databases with a direct 
export function: 
Login to the Library website and use the Digital Library  menu 
option to locate a particular database. 
Click on the database title to search it directly. 
 
Many of our database suppliers allow you to import references into RefWorks 
at the click of a button. 
Select the items from a database search and look for export reference functions like: 
• Export  
• Save/mail  
• Bibliographic Manager 
• Export to RefWorks 
NB: Each supplier of the databases offered via the Library web site will do this 
slightly differently, see examples below. 
 A few will not allow you to create a list and pull them through. Use the form filling 
method 3 or the import file method 5 for these exceptions. 
 

4.1 Digital Library: Check full text and RefWorks Direct Export tool 
Anglia Ruskin University’s Digital Library will check access to full text articles in other 
databases we subscribe to. When you are directed to this window, click on 
‘Advanced’ to find the RefWorks Direct Export tool. Click on ‘Go’ to export your 
reference. 
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4.2 ASSIA or BHI (or other CSA databases) 
• Log in to the Library website and use the Digital Library Database Finder to select 

your database. 
• Search and bring up your results list. 
• Tick the references you want. 

• Click on the RefWorks link.  

• Click on the export to RefWorks link.  

4.3 EBSCO Databases 
Note from RefWorks Technical Services 2011: Please export from the Ebsco Saved 
folder. If you export from Ebsco ‘Full view’, you may be closed out of the database. 
 
• Log in to the Library website and use  the Digital Library Database Finder to find 

your EBSCO resource 
• Open the database and perform a search 
 

• Select relevant records by clicking icon. 
• Then go to “Folder has Items” on the right hand side of the screen and click on  

 
• You will see a list of the records you saved. Select those to export to RefWorks by 

ticking the boxes next to them 
• Click on the Export icon. 

   
• Click the radio button beside Direct export to RefWorks  



 9

 
• Click Save    

      
Follow the procedure for the RefWorks account login (see 2.1) to import and view 
your references in the 'Last Imported' Folder. 
 

 

4.4 Science Direct (Elsevier) 
• Log in to the Library website and use the Digital Library Database Finder to find 

Science Direct. 
• Search and bring up your results list. 
• Tick the references you want. 

• Click on the export citations button at the top of the results list.  
• Choose which format you would like; citations only or citations+abstracts. 
• Check the RefWorks Direct Export toggle and click on export button.  
 

 
 
• If the next window is the RefWorks account login see 2.1 to import your 

references. 
• Check your references in the Last Imported Folder. 
• In Science Direct, click the Cancel button to return to your search results. 
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4.5 Google Scholar direct import. 
 
Warning: the quality of imported references using Google Scholar’s direct import can 
vary; always check the accuracy and completeness of the information by viewing and 
editing the form in RefWorks. An alternative for Anglia Ruskin full-text subscriptions 
linked through Google Scholar is the Digital Library RefWorks Direct Export tool (see 
4.1) 
 
To set up Google Scholar direct import: 
• From the Google Scholar search page, click on the Scholar Preferences link (top 

right) Set up Library links for Anglia Ruskin University. 
• Scroll down to the Bibliography Manager section. 
• Select ‘Show Links to import citations into’ and select RefWorks from the 

dropdown.  

 
• Click Save Preferences. 

 
To do a direct import to RefWorks: 
• After you have set up your preferences as detailed above. 
• Log in to the Library website and use the Digital Library Database Finder to find 

Google Scholar. 
• Conduct your search in Google Scholar 
• Each record in the results list will have an Import into RefWorks link:  

 

 
 

Note: If you use Google Scholar but are not logged into the library website, RefWorks 
will display the RefWorks account login (see 2.1) 
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4.6 Academic OneFile  
• Log in to the Library website and use the Digital Library Database Finder to select 

Academic OneFile and search the database. 
• View the results and select the references for exporting by ticking the boxes on 

the left-hand side 
• Click on ‘View all’ (top right) 
• From the ‘Tools menu’, Click on ‘Citation Tools.’ A Pop-up window will open. 
 

 
 
• In the ‘Export to third party software’, select ‘RefWorks,’ then click the ‘Export’ tab. 

 
 
• A tagged file will appear; click on the blue RefWorks link at the bottom to open 

RefWorks.  

 
 
• If the next window is the RefWorks account login see 2.1 to import your 

references. Check your references in the Last Imported Folder. 
 

4.7 OVID  
Log in to the Library website and use the Digital Library Database Finder to locate 
the OVID database you require.  Alternatively you may access the databases via the 
library website Advanced Search option.  
 
• Search the OVID database and tick the box(es) for those item(s) in the results 

screen which you wish to export into RefWorks. 
• Proceed to the menu at the top of the search results list to view options for 

displaying, printing, emailing or exporting your results. 
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• Click Export. 
• A pop-up menu provides options for exporting your results. Select RefWorks in 

the Export to drop-down menu. 
 

 
• Select the level of detail to be included in the exported reference e.g. Citation + 

Abstract. 
• Click Export citations. If the next window is the RefWorks account login see 2.1 

to import your references. 
• Your reference should go through into RefWorks but if you see the message:  
     ‘The RefWorks application is displayed in a new browser window.’   
Generally, this window opens on top of this page. If a second browser window has 
not launched, click this link to open the document.’, 
click on the link and your reference should be exported into RefWorks. 
• Check your references in the Last Imported Folder. 
 

4.8 Education Indexes; BEI, AEI and ERIC via ProQuest  
• Log in to the Library website and use the Digital Library Database Finder 

to select Education Indexes (BRI, AEI and ERIC) 
• Open the database and perform a search. 
• Check the box next to each item to select the reference for export. 
• Click the ‘Export’ icon at the top of the results list. 
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• In the Export window, select the level of detail required and ‘RefWorks,’ then click 

‘Continue’ to complete the export. 
• If the next window is the RefWorks account login see 2.1 to import your 

references. 
• Check your references in the Last Imported Folder. 
 

4.9 Emerald  
• Log in to the Library website and use the Digital Library Database Finder to select 

Emerald Fulltext 
• Open the database and perform a search 
• On Search Results screen, either: click on ‘View all results’  and select up to 10 

relevant records by ticking the box next to them or: 
• View an item in HTML format or as an abstract (option not available in PDF 

format)  
• In either view there is an option to ‘Add to Marked List Session,’  

  
• Click on the ‘Go’ button to include this in your selection.(To save your list for later 

you will need to create an Emerald account under Emerald Profile, a link to this 
will appear when you save an item,  ) 

• Click ‘Go’ to add your selections to the Session Marked List (maximum of 10 
items) 

• Click on ‘Marked List’ in the left hand column [1] then view the Marked 
List Session (reproduced below) 
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• Select the Marked List session [2], and select the items [3] in this session that you 

wish to export to RefWorks. 
• Click on Export options [4] 
• In the next window, click on ‘Export to RefWorks.’ 
 

.  
 
• If your RefWorks Account is already open, it will complete the export. If the next 

window is the RefWorks account login see 2.1 to import your references. 
• Check your references in the Last Imported Folder. 
 

4.10 Wiley Online Library  
• Log in via the Library website and perform a search. To export multiple 

references from Wiley Online Library, click the box next to your selected items.  
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• Click on the “Export citation” link at the top or bottom of the page.  

 
 
• To export an individual journal reference, look for the “Article tools “menu and 

click “Export citation for this article.” The Export citation options will open. 
• The Export citation page asks you to select a format from a drop-down list. Select 

RefWorks, then your choice of citation or citation &abstract. 
 

 
 
• Click Submit. On campus, RefWorks will open and import your selection. 
• If the next window is the RefWorks account login see 2.1 to import your 

references. 
• Check your references in the Last Imported Folder. 
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4.11 Web of Science (ISI Web of Knowledge)) 
• Log in to the Library website and use the Digital Library Database Finder to select 

Web of Science. 
• Search and bring up your results list. 
• Tick the references you want to export. 
• Scroll to the bottom of the page, to the Output Records box. 
• Selected Records will already be ticked (Step 1) 
• Choose how much information you want the references to include (Step 2) 
• Click on the RefWorks button (Step 3) 
 

 
 
• Your records will automatically be imported into your Last Imported folder in 

RefWorks.  
• If the next window is the RefWorks account login see 2.1 to import your 

references. 
• Check your references in the Last Imported Folder. 
 

5.  Importing a saved text file from a database using an 
import filter. 
Some databases do not offer a direct export process; if you can save a text file of 
your search results this can be imported into your RefWorks database. 

5.1 Pubmed 
• Log in to the Library website and use the Digital Library Database Finder to select 

Pubmed and perform your search. 
• View the results and select the references by ticking the select boxes on the left 

hand side.  
• In the ‘Display settings’ drop down menu (at the top or bottom of the results 

screen), select MEDLINE and click Apply. The display will change to a tagged text 
file. 
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• To save the text file, click on File in your browser menu and select Save As; 

Choose "Yes" when a small pop up box appears. 
• Choose where you wish to save e.g. Desktop, and change the Save As type 

drop-down menu to Text File (*txt), then click on Save. Close this file. 
• Login to RefWorks. 
• In the RefWorks menu, click on References>Import on the top menu. 
• At the Import screen - select Import Filter/Data Source – NLM PubMed. 
• Under Database select PubMed. 
• ‘Select the Text File’ - Browse to find your PubMed file, select open and then 

within RefWorks,  
 

 
• Click the ‘Import’ button. 
• Check your references in the Last Imported Folder. 

5.2 Cochrane 
• Log in to the Library website and use the Digital Library Database Finder to select 

Cochrane and perform your search. 
• Select the record(s) you wish to export to RefWorks and click on ‘Export citation’ 

or ‘export selected citations’ at the end of the list. 
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• In the pop up ‘Export Citation, box click on Submit.  If required change the Export 
Type to Citation and Abstract and PC to MAC using the drop down menu.  

 

 
 
• At the Save window, click on Save and note where you save to e.g. desktop and 

change and note down the .txt file name for future reference.  
• Log in to RefWorks with your University Login, following the link on the library 

website under Referencing – RefWorks.  
• Once in RefWorks select from the main top menu: References> Import. 
•  In RefWorks at the ‘Import References’ pop up window, choose Cochrane 

Library for the Import Filter/Data Source and Cochrane Database of 
Systematic for the Database field.   

 

 
 
• Click on Browse and search for your saved file.  Click on open to get the file 

name into the Select Text File box.  
• Close this window down, and then in RefWorks, click on ‘Last imported’ folder on 

the right. 
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5.3 Importing references from the Library website Quick search:  

Books, E-books etc. 
• Log in to the Library web site and use Quick search for Books, E-books etc. 
• From the results list, select the relevant tick boxes for the references you wish to 

import. 
 

 
• In the ‘E-Mail or save selected records’ window, choose ‘full format’ from the 

drop-down format menu and click the  button at the bottom of the page. 

 
• On the next screen click to save the file to your PC. Note the file name 

so that you can import it into RefWorks later. The format will be .sav, e.g. 
SAV7683.sav 

• Log in to RefWorks. Click References, then import. 
• Pick Ex Libris Aleph from the first drop down menu and then Anglia Ruskin from 

the second. 
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• Browse for your .sav file to import and click the import button. 
• Then click on ‘View Last Imported Folder’ to see the references. 
 
Note 1:  if you are using the Anglia Ruskin University student network PC’s on 
campus, the .sav file may be identified as an SPSS file. This does not prevent 
successful import to RefWorks, but if you open the file it will launch SPSS. 
 
Note 2: Downloading is not available from ‘My Book e-shelf’.  
 

5.4 Importing references from the Library website: Journal Articles 
etc. 
 
One item at a time: 
• Log in to the Library Website & search. 

• Click on the title in the results list. 
• Click on the ‘Check fulltext’ link in the Full View. 
• Click on the ‘Advanced’ Link. 
 

 
 
• Click on Go button next to ‘Download Record into RefWorks Direct Export Tool.’ 
• If the next window is the RefWorks account login see 2.1 to import your 

references. 
• Check your references in the Last Imported Folder. 
 

5.5 Multiple items 
To pull through several items from an Advanced Search in one go: 
• Click on the trolley icon  next to all the references you want to take into 

RefWorks. 
• Go to My Digital Library, My Jnl  Articles eShelf 
• Click select all or select those that you want 
• And then click ‘selected’ at the top or bottom of the list 
• Click Save on the next screen. 
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• Change your record format to RefWorks and click Save and your references will 

be exported to RefWorks. 
• If the next window is the RefWorks account login see 2.1 to import your 

references. 
• Check your references in the Last Imported Folder. 
 

6. Organising and managing references within your 
RefWorks database. 
Use the ‘View’ option on the menu bar or the ‘Organise and share folders’ tab which 
summarises your folder information. You can manage the sharing function which 
supports collaborative research. 
 

6.1 Creating folders to keep information organised and easy to 
share. 
RefWorks comes with a folder set up for ‘Last Imported’ references. All references 
will be ‘not in a folder’ unless you set up your own folders. There is no limit on the 
number of folders you can create within your RefWorks account.  
• Click on the New Folder button. 
• Type a name in the text box and click Create. 
• RefWorks 2.0 also allows you to create subfolders from the ‘Organise and share 

folders’ tab. 

 

6.2 Putting References from ‘Last Imported’ into another folder. 
• Open the ‘Last Imported’ folder.  
• Tick the box next to the Ref ID to select the item/s to move. 
• Hover over the ‘Add to’ icon. 
• Choose a folder by scrolling down the dropdown menu.  
• Note the screen message while processing the action. You can choose to put the 

same item in multiple folders. 
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7. Output Your References: a quick bibliography using an 
Output Style 
Any folder or list of citations can be quickly formatted into any of the bibliographic 
styles in RefWorks. You can use this to preview the output and check you have 
accurate information for your references. 
• Click on Bibliography in top menu, or click the Create Bibliography button.  
• Choose an output style from your drop-down list of favourites. 
• Choose file type e.g. Word 
• Choose References to include. 
• Click on Create Bibliography button. 
• Check the processing information (bottom right) for progress. If your file does not 

download, click the link in the processing report to open the file.  
 

 
 
NB: You can output in many styles for different publications using the list in the 
Output Style Manager OR you can create your own style – following instructions in 
the online help. 
• If the output is inaccurate, view and edit the source reference in your RefWorks 

database. 

7.1 Format a document plus bibliography using One line/Cite View. 
This method can be used to create bibliographies with in-text citations in most word 
processing programs. You can also use the ‘One line/Cite View’ feature to generate 
the placeholder and Ref ID to copy and paste into your word-processed document. 
 
To cite a reference in text your document: 
• Open your folder  and use the ‘Change view’ option on the ‘References’ tab 

select One line/Cite View . 
• Click on the ‘Cite’ icon next to the reference you want to include. A Citation 

Viewer window will appear containing the format for a temporary citation place 
holder. {{54 Johnson;}}. 

• To cite a second reference in the same location just click on the Cite Link by any 
other reference. 

• Once you have all of the references you need for a particular in-text citation, click 
on the Select button. 

• Copy and paste into the correct place in your word-processed document. 
 

7.1.1 Adding page numbers 
You can add a page number to the Ref ID by typing /f p. and the page number inside 
the place holder brackets e.g.: {{1039/f p.33}} OR {{1039/f 
p.33;1028}} 
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7.1.2 Creating a Bibliography in One line/Cite View 
• Save the document you have created with placeholders before processing.  
• Click the ‘Bibliography’ button in the Citation Viewer window or the ‘Create 

Bibliography’ button within the RefWorks window. 
• Select the Output Style you need. 
• Click on ‘Format paper and bibliography’ and browse to find your document. 
• Click on ‘Create Bibliography.’ When the processing is complete, open the file. 
• RefWorks creates a new formatted ‘Final’ document with in text citations and 

bibliography. 

7.2 Write-N-Cite III for Microsoft Word. 
The Write-N-Cite tool can be downloaded onto your own PC or Laptop as a utility for 
use with Microsoft Word only. Anglia Ruskin staff with a University PC or laptop can 
download it from the network using Start>All Programs>Advertised Programs. 
 

7.2.1 Downloading Write-N-Cite III with Library login off-campus: 
• Start at the Library website and login to your RefWorks account. 
• Follow the detailed instructions on the Tools tab within RefWorks to download the 

version of Write-N-Cite III compatible with your operating system. If you wish, 
select ‘Allow working off-line’ to enable this function. 

• After you have installed Write-N-Cite III, open it from within Word by clicking the 
toolbar icon in your quick start menu, desktop icon, or by selecting it from the 
Tools drop down menu (Windows users only).  

 

7.2.2 To use Write-N-Cite III with a Word document   
• Click on the Write-N-Cite icon which will open the RefWorks account 

login window and login (See 2.1). If you launch the program from the desktop icon 
or the Start menu, it automatically opens a copy of Word. 

• When writing your document in Word, click at the point where you want the 
reference inserted. 

• Switch to Write-N-Cite III and click the Cite link next to the correct reference. 
Write-N-Cite III automatically inserts the opening and closing curly brackets as 
well as the Ref ID, Author Last Name and Year.  This is called a ‘Temporary 
Citation Placeholder’ and it is what RefWorks reads when formatting your paper. 
 It is not what your final citation will look like. 

• To edit references, e.g. add page numbers in Write-N-Cite III, use the ‘edit 
citation’ function (top right) 

7.2.3 To format the paper and create the bibliography: 

• In Write-N-Cite go to the Bibliography tab. Select the correct ‘Output Style’ and 
click ‘Create Bibliography.’ You do not need to select the file since Write-N-Cite is 
already linked to the current document. The program formats your document with 
the in-text citations and the bibliography.  A “Document processed’ message will 
display when the formatting is complete and you can save the finished paper. 
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Note: If you wish to remove hyperlinks from the bibliography to comply with Anglia 
Ruskin Harvard Style v2: 
• Once the document is ready for submission, save a second copy of the 

document. 
• Highlight the bibliography and hit CTRL+SHIFT+F9; this will remove the 

hyperlinks. It will however also remove the mark-ups in the background, so this 
should only be done to a second copy and just before submission / publication. 

 

8. Other RefWorks 2.0 functions to explore:  
RefWorks 2.0 offers a number of other tools and functions which are fully explained 
in the RefWorks online tutorials and help file. The RefGrab-It tool captures 
bibliographic data from web pages such as Amazon to import into your RefWorks 
database.  
You can search other online catalogues e.g. the British Library from inside RefWorks 
and import the results. 

8.1. Working off-line 
• Create a folder and add all of the references you require when working off-line.  
• Click on Export and select the folder you want to print.  
• Select Citation List.  
• Click Export to Text File. When the file displays print it using the browser's Print 

function. 
• Your printout or file will provide you with the RefIDs which you need to use in your 

document as citation placeholders.  
• To manually insert citations in the text where you want to cite the reference, use 

two open curly brackets "{{" followed by the Reference ID number followed by two 
closed curly brackets "}}". For multiple citations in the same location separate the 
Ref ID number with semicolons: {{34;45;23}}.  

• You will need to go back online to generate the bibliography or reference list by 
going to the Bibliography area and browsing to find your file. 

 

9.  Trouble-shooting common problems: 
Always check your references for accuracy and completeness by viewing and editing 
the form before generating your bibliography.  
 
• First check the output style: have you selected the correct version of Harvard 

used by Anglia Ruskin University?  
• Have you selected the correct Ref Type? The default on the form is Generic; this 

is used for used for all undefined record types, you may need to check and alter 
the Ref Type to book/journal etc. 

• Have you selected the correct Source Type for the reference? Selecting 
Electronic will ensure that the correct information fields relevant to an electronic 
source are used; if this is left on Print they will fail to appear in your final 
bibliography. 
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• Have you completed the author field with the surname first followed by a comma, 
then the initials ending with a full stop? If there are multiple authors place a semi 
colon between each author’s details. The Reference Types are set up to add any 
other punctuation required. 

• Check imported page number ranges for journal articles as occasionally only the 
start page comes through. 

• Click on Edit next to each record to make any alteration on the form and 
remember to save the changes you make. 

• Use the guide to the Anglia Ruskin Harvard system of referencing 
www.libweb.anglia.ac.uk/referencing/harvard.htm  to check the final version of the 
bibliography from your RefWorks database. 

10. Help 
Tutorials providing guidance and detailed advice for RefWorks 2.0 are available in 
different formats in the RefWorks 2.0 ‘Help’ menu.  
 
RefWorks ‘Help’ file has detailed information and ‘Frequently asked Questions.’ 
 
You can request technical support using the ‘Contact us’ link within your RefWorks 
account. 
 
For help with RefWorks 2.0 from the University Library 
 
• Ask at the Reception or Enquiry Desks within the library. 
• Visit the online Help & Advice section of the library website. You can “Ask Us” by 

phone, email or online chat at: 
 
 www.libweb.anglia.ac.uk/askus 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RefWorks 2.0 Edition updated 22/11/2011 


	RefworksGuide2011_P1.pdf
	RefworksGuide2011.pdf

